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1. Introduction 

The NordicEM24 Post-Process utility developed by Instrumentation GDD inc. allows you to 
visualize collected raw data, stacks, decays, profile, to compute a Spectrum analysis of the 
stacked data and to generate new output files from the raw data using different survey 
parameters. The original files can be re-processed with new parameters such as: 
Transmitter Current (for current normalization), Stacking Algorithm, Delay (correction for 
timing error), Ramp (turn-off time) and Window Scheme. You can also apply a sensor 
conversion factor, invert the signal of a single or multiple readings or discard noisy decays 
from the final stack. The output data file is compatible with third parties data analysis and 
inversion software. Custom Export functions can also be created on demand. 

 

2. Installation 

The NordicEM24 Post-Process utility will be provided with the purchase of the NordicEM24 
receiver. The software is compatible with Windows XP, 7, 8 and 10. When installing the 
software for the first time, you will get a 30-days license activation. In order to get your full 
license, you will need to send an activation request by internet to Instrumentation GDD.  
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3. Software overview 

Main Window 

 

The Main Window is divided in three sections: 

- Menu Bar: File, View, Tools, Window and About 

- Task Bar: Project and Graph 

- Data/Graph Window 

  

Data/Graph 

Window 

Task Bar 

Menu Bar 
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Menu Bar 
Use the Menu Bar to access software options and settings. 

File menu: allows basic command such as opening a Project or File, Save, Close 

Save: Save project files and create new binary stack files if required. 

Export: Save the active window’s raw or stacked data to a text file (ASCII). Use this option 
to import raw or stack data into a third-party data processing software. You must open the 
corresponding tab to select the input data file to be exported. Note that this option is not 
available for Data, Spectrum, Decay and Profile tab.  

Clean up project: The project file will store information on associated stack and raw files. If 
the information is out of date, use this feature to re-scan the project folder and clean the 
file library. This will also clear the recent file/project history. 

Reset to Defaults: Global settings will be cleared and reset to their installation defaults. 

 

View menu: To open the graph tool box, use the View->Show tool box option. 

 

The tool box will appear to the top right of the Data/Graph window as: 

 

No interaction mode 

 
Pan mode 

 
Zoom in mode 
 

Zoom out mode 
 

Zoom fit 
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Tools menu:  

 

Window Scheme: Open the Window Scheme Editor. This feature allows changing the size 
of the window (Begin and End), visualizes the resulting windows on a graph and creating 
new schemes. 

 

 

To create a new window scheme, click on   
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Note that by default the NordicEM24 post-process window scheme will be generated in xml 
format. 

You can also import a window scheme from a *.csv or from a NordicEM24 *.dat file. 
Following is an example of a *.csv file with “beginning of time window, end of time 
window”. 
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Sensor Conversions: Open the Sensor Conversion Editor to view, edit or create new sensor 
conversion template. 

 

 
Settings: Set the GPS format and customise the DATA window headers. Change the Display 
theme (dark or light).  
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Window menu: Change the appearance of the opened graphical windows. 

 

 

About: Displays the current version of the software. 

 



Instrumentation GDD inc. 2017-01-12 Page 10 

 

Task Bar 
The Task Bar gives information on the project and graph parameters. 

 

 

Data/Graph Window 
The Main Window allows visualizing data and graphs.  
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4. Getting started 

Create a new project 
• Save your data files to your Computer 

• Start the Post-Process software by clicking on the software icon . 

• Create a project by selecting File->New project… 

 

• Browse to the folder containing your data (*.dat, *.stk, *.raw) and open de Data file 

*.dat. The following window will appear, click on Create 

 

• The project name will appear in the project window. 
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5. Visualizing your Data 

Double click on the file name in the project task bar. A progression bar will appear at the 
bottom of the window while the software scans the project folder to add associated stack 
and raw files (*.stk, *.raw) to the project. 

Note: The data files must be located in the same directory or within up to 5 sub-directories. 
If the data files are added later, use the Cleanup Project to rebuild the library. 

 

DATA panel 
The following window will appear with the DATA tab opened. This table is a simple 
representation of the original *.dat file. Select a reading in the DATA table that will be 
displayed in the graphical windows.  

 

 

The search bar allows you to quickly find readings by their number or custom properties. 
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RAW panel 
Open the RAW tab to visualise the RAW data. All sampled data points are saved in the raw 
file. You must have selected the SAVE RAW DATA option in the NordicEM24 receiver 
otherwise they were not saved.  

 
 

The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. 
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Use the graph task bar to the left of the screen to navigate through the readings, set axes 
limits, show or hide a component or reset to the default settings.  
 

STACK panel 
Click on the STACK tab to display the stacked data. 

Along with the standard features, the graph task bar includes a “Zoom on Ramp” function 
to quickly zoom on the turn off ramp when the stack data is displayed.  
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The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. 

Use the graph task bar to the left of the screen to navigate through the readings, set axes 
limits, show or hide a component or reset to the default settings.  

SPECTRUM panel 
Open the SPECTRUM tab to analyse the frequency content of a stack file. As it is not relevant 
to analyse the signal when the transmitter is running, only the off time portion of the 
stacked data is processed. The Zoom Editor is replaced with a stack viewer along with two 
cursors (in red) that allow you to manually specify the spectral analyse interval. In order to 
get better results, you should move the cursors toward the center portion of the off time 
until the turn off ramp and the turn on spikes are rejected.   

 

Use the graph task bar to apply a linear or logarithmic scale to the vertical axis and chose a 
specific Spectrum type between Amplitude Spectrum, Power Spectrum and Power 
Spectrum Density.  

Zoom buttons are added to the graph to allow scaling the X and Y Axis: 

 



Instrumentation GDD inc. 2017-01-12 Page 16 

 

DECAY panel 
Open the DECAY tab to display the windowed data. In order to plot both positive and 
negative values on the same graph, a linear transition is created around zero when the 
logarithmic scale is selected. Use the graph task bar to change the axes scales, set the 
logarithmic transition threshold and select the channels to be displayed. 
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PROFILE panel 
If the input .dat file contains readings that where created with different window schemes, 
the Graph task bar will include a setting that allows you to choose either to plot the profile 
only with reading associated with a specific scheme or to plot them all on the same graph.  
You can also modify the vertical axe scale, set the logarithmic transition threshold, modify 
the station range on the X Axis and the Window # Range and select the channels to be 
displayed. 
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6. Modifying your survey parameters 

To re-process your data, click on the Add Filter Icon  or right click on the .dat file in 
the task bar and choose add new filter. The Filter Editor will appear. 

The upper part of the window contains the parameters controls while the lowest part recalls 
the current readings information.  

 

 

To modify a parameter, you must first select one or more reading. To do so, you can click 
directly in the corresponding cell to highlight it: 
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You can also select the whole line if you want to change more than one parameter by 
clicking in the left margin or select multiple cells to quickly change several parameters for a 
range of readings. By clicking on the upper left corner all cells are highlighted. 

You may now enter a new value in the upper area. 

 

 

If some data files are missing, a red icon  will be displayed in the left margin of the Filter 
Editor. Put your mouse over it to get details. If only the stack file is missing a new one will 
be created with the raw file and all parameters might be modified. However if the raw file 
is missing, the stacking algorithm, the time shift and the stacking interval can’t be modified. 
If both files are missing, no post-processing is possible. In this case the line will be grayed 
out. If the data files are added later, use the Cleanup Project to rebuild the library and re-
allow post-processing of this reading.  

 

 
If you want to cancel a modification, you can always revert back to the original value. Use 
the right mouse click to have access to this option. 

 

 
To save your filter, give it a name and click on the Save button. 

A new data file will appear in the Project task bar. You can double click on the file name to 
visualise the processed data. 
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Once the new filtered file has been created, you can navigate in the DATA, STACK, 
SPECTRUM, DECAY and PROFILE panels to visualize the results. 

 
It will then be possible to re-stack one or more readings from the RAW data by manually 
selecting a series of half-cycles with the orange arrows of the Raw window. New *.stk files 
will be created accordingly in your working directly (the original files will remain intact). In 
addition, the filtered *.dat file will be updated. 
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It is also be possible to graphically adjust the Delay and Ramp values of specific readings 
directly from the STACK panel. To do so, drag the green (Delay) and Red (Ramp) dashed line 
with your mouse to the desired time position.  

 

 

You can always modify the parameters of a filter file by right-clicking on it in the Task Bar. 
Select “Properties” and the filer editor will open.   

 

 

 

 
 
 
 
 

 

If you delete a filter, the corresponding .dat and .stk file(s) will be automatically deleted 
from your working repertory.     
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7. Discarding Noisy Decays 

The NordicEM24 Desktop Post-Process software allows discarding noisy readings from a 
dataset. For every decay discarded, the corresponding data line in the .dat file will be erased 
in the new “_reduced.dat” file created by the software. The original .dat, .stk and .raw files 
will remain unchanged.  

To proceed, click on the Add Filter Icon  or right click on the .dat file in the task bar 
and choose add new filter. The Filter Editor will appear. 

In the case of discarding noisy decays, all that is required is to select the readings your wish 
to clean and rename your new post-process file.  Note that you can still modify survey 
parameters if needed (refer to section 6).  

To save your filter, give it a name and click on the Save button. 

 

A new data file will appear in the Project task bar. You can double click on the file name to 
visualise the processed data. 

 

 

You can now discard noisy readings, component by component, by clicking them directly on 
the DECAY panel using your left mouse button. The selected decays curve will become 
dashed. You can unselect them by clicking again.  

We recommend you use the display “All” option to visualise every decays at a specific 
station and validate which decays are erratic. Note that the PROFILE panel will be updated 
simultaneously as you discard readings.  
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The * next to the name of your project, eg. Project (1), at the top left of your screen indicates 
that your cleaned .dat file has not been saved yet. In order to save the cleaned .dat file, you 
need to go in the “File menu” and select “Save”. This may take some time and a Progress 
Bar will appear on your screen. Your new file will be labelled “_reduced.dat”. 

 

 

 

Note that your Post-Process *.dat file will contain the whole set of data and will allow you 
to visualise through the NordicEM24 Desktop software, which decays were kept and which 
were taken out.  

 

 

Discarded 

Discarded 

Discarded 
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8. Generating a .dat file from .stk or .raw files 

The NordicEM24 Desktop Post-Process software allows to regenerate a missing DAT file 
from a collection of STK or RAW binary files 

1. Copy the binary *.raw and *.stk files from you NordicEM receiver to your computer 
2. Open the GDD EM Post-Process software and create a New project. You might have to 

close the current project before. 
3. In the open file dialog, change the target file type to "STK or RAW Data Files (*.stk, 

*.raw)" 
4. Browse to the location were your binary files are saved and select them all to include 

them in the project. 
5. Enter the name of the project. The new DAT file will be named after the project name 
6. Since the original DAT file is missing, some associated survey parameters cannot be 

retrieved. You then have to manually set the Windows Scheme and Primary Voltage 
window's Start and End time (VPRI Start/End). The required fields will be highlighted in 
a Filter Editor dialog. 

7. To properly set the missing parameters, select all reading by clicking in the upper left 
corner of the spreadsheet. In the upper part of the editor, you can now set the 
parameters globally. 

8. Once you click on the Save button, the DAT file will be created in the same directory as 
the binary files. 
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9. Time Shift option 

The Time Shift filter option of the NordicEM24 Desktop Post-Process software allows to 
modify the way the STACK is organised time-wise. This option will be useful to extract decay 
channels out of the On-time portion of the full wave data. By default, the STACK is organised 
as followed, with the second half of the On-time (+), the full off-time and then the first 
portion of the next on-time (-). The Time Shift parameter will displace the STACK’s starting 
time further away (i.e. later). Valid values must range between 0 and 
1/(Base frequency x 2). 

The following figure presents an example for a B-Field survey using a 0.5Hz base frequency 
(500ms off-time duration).   
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For example, by applying a Time Shift of 750ms to this dataset, the STACK starting point will 
be pushed 750ms later. The RAW panel of the corresponding filtered files will display the 
location of the new STACK starting time. 

 
The filtered data will consequently be organised as follow, with one complete on-time (-) 
followed by a complete off-time period:  

 
This new STACK will allow to extract decay channels from the on-time portion of the full 
wave data. Note that the first time window will be located by default in respect to the 
beginning of the off-time (t=0) even though its location has changed graphically using the 
Time Shift. User will have to create a new Windows Scheme with negative timing in order 
to extract on-time decays information.  
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10. Time reference 

 
Time 0 (T=0) refers to the beginning of the turn-off time (or beginning of ramp). This time 
reference will be used when computing the primary field (VPRI). The Windows Scheme, 
used for the Decay discretization, will begin at (T=0) + Ramp. If a Time Shift is applied, the 
time reference will not change, thus, VPRI “start” and “end” values will remain coherent. 
Windowed decay data will not be affected by the Time Shift either meaning that the 
beginning of the first time window will still be relative to the end of the ramp. Note that 
time windows extending after the end of the Off-time will not be computed. On the other 
end, the Delay will impact on the location of T=0. It will push the stacked waveform back 
and forth. Refer to the figures below. 
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11. Technical help 

If you encounter a problem not described in this manual, do not hesitate to contact 
Instrumentation GDD Inc. for help at: 
 
Tel.:  (418) 877-4249 
Fax:  (418) 877-4054 
Toll free line:  1 877 977-4249 
e-mail:  support-technique@gdd.ca / gdd@gdd.ca 
 
 
Emergency out of business hours: 
 
Pierre Gaucher: Home phone:  (418) 657-5870 

Cell phone:  (418) 261-5552 
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